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Section Id : 2549894307
Section Number : 1
Section type : Online
Mandatory or Optional : Mandatory
Number of Questions : 52
Number of Questions to be attempted : 52
Section Marks : 52
Enable Mark as Answered Mark for Review and Clear Response : Yes
Sub-Section Number : 1
Sub-Section Id : 2549894348
Question Shuffling Allowed : Yes

Question Number : 1 Question Id : 2549896255 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :

Key Value

Difficulty Level Easy

Item Year CPCT 2021

Topic Software

Sub Topic Operating Systems

Micro Topic Windows

Objective Knowledge

Section Familiarity with computer systems




|Form

ISET 52

Files are organised by storing them in

Options :

1. # tables

2. % databases
3. % folders
4. % graphs

Question Number : 1 Question Id

Correct Marks : 1 Wrong Marks :

: 2549896255 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
0

Question Key Details :

Key Value

Difficulty Level Easy

Item Year CPCT 2021

Topic Software

Sub Topic Operating Systems

Micro Topic Windows

Objective Knowledge

Section Familiarity with computer systems
Form SET 52

T WR B BIEd B I Yd G S 2 |

Options :
1. % ¢od
2. % ST
3. ¥ it
4. % Yth

Question Number : 2 Question Id

Correct Marks : 1 Wrong Marks :

Question Key Details :

: 2549896434 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No

0

Key

Value

Difficulty Level

Easy




Item Year CPCT 2021

Topic Software

Sub Topic Computer Languages

Micro Topic Compiler

Objective Knowledge

Section Familiarity with computer systems
Form SET 52

A tool that converts an entire program into machine language is called a/an:

Options :

1. #* Interpreter
2. % Simulator
3. ¥ Compiler

4. % Commander

Question Number : 2 Question Id : 2549896434 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Easy

Item Year CPCT 2021

Topic Software

Sub Topic Computer Languages

Micro Topic Compiler

Objective Knowledge

Section Familiarity with computer systems
Form SET 52

T R T 1 7= Bt U H gRkafcfd 3 are gt Hgad gl

Options :

], % FRUYR
2. % g
3. % ISR
4. % HHSI




Question Number : 3 Question Id : 2549896490 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Easy

Item Year CPCT 2021

Topic Hardware

Sub Topic Generations types and parts of computers
Micro Topic Memory Unit

Objective Knowledge

Section Familiarity with computer systems
Form SET 52

Which of the following is the fastest memory in a computer system?

Options :

1. * ROM

2. % RAM

3. ¥ Cache

4. % Hard Disk

Question Number : 3 Question Id : 2549896490 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Easy

Item Year CPCT 2021

Topic Hardware

Sub Topic Generations types and parts of computers
Micro Topic Memory Unit

Objective Knowledge

Section Familiarity with computer systems

Form SET 52

e # 3 Pl e yomelt () ged ao 99K gt 82



Options :

1. ¥ ROM

2. % RAM

3. ¢ B (Cache)
4. % TS f&B

Question Number : 4 Question Id : 2549896566 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No

Question Key Details :

Correct Marks : 1 Wrong Marks : 0

Key Value

Difficulty Level Easy

Item Year CPCT 2021

Topic Hardware

Sub Topic Storage Devices

Micro Topic Others

Objective Knowledge

Section Familiarity with computer systems
Form SET 52

As per the latest technology context the storage capacity of a hard drive is measured in:

Options :

1. # Bytes

2. ¥ Terabytes
3. # Bits

4. ¥ Nibble

Question Number : 4 Question Id

Correct Marks : 1 Wrong Marks :

: 2549896566 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
0

Question Key Details :

Key Value
Difficulty Level Easy

Item Year CPCT 2021
Topic Hardware




Sub Topic Storage Devices

Micro Topic Others

Objective Knowledge

Section Familiarity with computer systems
Form SET 52

TaaH Uit Ty & SR 818 $13d &1 HSRUT & P! fhad AT ST 82

Options :

1. % dlgcH
2. ¢ ERC
3. % ooy
4. % {Yed

Question Number : 5 Question Id : 2549896887 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
Question Key Details :

Key Value

Difficulty Level Easy

Item Year CPCT 2021

Topic Hardware

Sub Topic Output Devices

Micro Topic Printer (impact oor non-impact)
Objective Knowledge

Section Familiarity with computer systems
Form SET 52

The output of an image through a printer is often called

Options :

1. # soft copy

2. % hard copy
3. ® large copy
4. % small copy

Question Number : 5 Question Id : 2549896887 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No




Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Easy

Item Year CPCT 2021

Topic Hardware

Sub Topic Output Devices

Micro Topic Printer (impact oor non-impact)
Objective Knowledge

Section Familiarity with computer systems
Form SET 52

flfex & H1eaw ¥ U BT P 3TSTYE B SRR HET o g |

Options :

1. % U Hidt
2. ¢ gTS Bl
3. % QS HIUT
4. % A DU

Question Number : 6 Question Id : 2549896889 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Easy

Item Year CPCT 2021

Topic Hardware

Sub Topic Input Devices

Micro Topic Keyboard

Objective Knowledge

Section Familiarity with computer systems
Form SET 52

Which of the following keys is known as a toggle key?

Options :
1. % Num Lock




2. # Delete
3. % Alt
4. % Control

Question Number : 6 Question Id : 2549896889 Question Type
Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Easy

Item Year CPCT 2021

Topic Hardware

Sub Topic Input Devices

Micro Topic Keyboard

Objective Knowledge

Section Familiarity with computer systems
Form SET 52

9 7§ S I ot DI <h1d B (ol & = H ST ST 82

Options :

1. ¥ Num Lock
2. % Delete

3. % Alt

4. # Control

Question Number : 7 Question Id : 2549896325 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
Question Key Details :

Key Value

Difficulty Level Medium

Item Year CPCT 2021

Topic Software

Sub Topic Proprietary Software

Micro Topic

Microsoft Office

: MCQ Option Shuffling : Yes Is Question Mandatory : No




Objective Application

Section Familiarity with computer systems

Form SET 52

Which of the following is a database management system?
Options :

1. # MS Word

2. % MS Access

3. % MS Excel

4. ¥ MS PowerPoint

Question Number : 7 Question Id : 2549896325 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Medium

Item Year CPCT 2021

Topic Software

Sub Topic Proprietary Software
Micro Topic Microsoft Office
Objective Application

Section Familiarity with computer systems
Form SET 52
frafafad # 9 o 91 Screy ydeH YUl (Serey Aavice Ried) 82
Options :

1. % MS Word

2. % MS Access

3. % MS Excel

4. % MS PowerPoint

Question Number : 8 Question Id : 2549896332 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :




Key Value

Difficulty Level Medium

Item Year CPCT 2021

Topic Software

Sub Topic Application Software
Micro Topic Database

Objective Knowledge

Section Familiarity with computer systems
Form SET 52

The data type is used to store numbers only.

Options :

1. ¥ memo

2. % text

3. % number

4. % date / time

Question Number : 8 Question Id

Correct Marks : 1 Wrong Marks :

: 2549896332 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
0

Question Key Details :

Key Value

Difficulty Level Medium

Item Year CPCT 2021

Topic Software

Sub Topic Application Software

Micro Topic Database

Objective Knowledge

Section Familiarity with computer systems
Form SET 52

201 UPR BT ITAN] Had BT B TR B4 & o fear smar g1

Options :
1. % Ahl
2. % TR
3. ¢ R




4. % feqi® / 99g

Question Number : 9 Question Id : 2549896438 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Medium

Item Year CPCT 2021

Topic Hardware

Sub Topic Generations types and parts of computers
Micro Topic Memory Unit

Objective Knowledge

Section Familiarity with computer systems
Form SET 52

How CPU reads the information from secondary memory?

Options :

1. ¥ First information is transferred to main memory and from there, the CPU reads
2. # Directly from secondary memory

3. % Through registers

4. # Through bus

Question Number : 9 Question Id : 2549896438 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :

Key Value

Difficulty Level Medium

Item Year CPCT 2021

Topic Hardware

Sub Topic Generations types and parts of computers
Micro Topic Memory Unit

Objective Knowledge

Section Familiarity with computer systems

Form SET 52




fecia AR & @ Edig (cPu) TerT ) H9 Ted 82

Options :

1. ¢ Ugd YaH &1 G- BHR # AR faar Sdr § ¢k a8t ¥ Wiy (cPU) UgdT 8
2. % T fgda A Y ugdr 8

3. % IR P GR

4. % §Y P GRT

Question Number : 10 Question Id : 2549897583 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value
Difficulty Level Medium

Item Year CPCT 2021
Topic Hardware

Sub Topic Storage Devices
Micro Topic Others
Objective Knowledge
Section Familiarity with computer systems
Form SET 52

Full form of EPROM is:

Options :

1. ¥ Erasable Programmable Read Only Memory

2. # Exponential Programmable Read Only Memory
3. # Expandable Programmable Read Only Memory
4. % Extensive Programmable Read Only Memory

Question Number : 10 Question Id : 2549897583 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Question Key Details :
Key Value
Difficulty Level Medium

Item Year CPCT 2021




Topic Hardware

Sub Topic Storage Devices

Micro Topic Others

Objective Knowledge

Section Familiarity with computer systems
Form SET 52

EPROM &1 [T &Y &1 §?

Options :

1. ¢ siﬁaa Tued IS SiFd AR (Erasable Programmable Read Only Memory)

2. # Wﬁl’qﬁ ged IS $iFc AHR (Exponential Programmable Read Only Memory)
3. % Qaﬂﬁ@aﬁ Uaed S el AR (Expandable Programmable Read Only Memory)

4. % TRy MU T8 3 AARY (Extensive Programmable Read Only Memory)

Question Number : 11 Question Id : 2549897721 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Medium

Item Year CPCT 2021

Topic Hardware

Sub Topic Input Devices

Micro Topic Touch Screen

Objective Knowledge

Section Familiarity with computer systems
Form SET 52

Which of the following is used in automated teller machines or public information kiosks?
Options :

1. ¥ Touch screens

2. % Pens

3. # Microphones

4. % Stylus



Question Number : 11 Question Id : 2549897721 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Medium

Item Year CPCT 2021

Topic Hardware

Sub Topic Input Devices

Micro Topic Touch Screen

Objective Knowledge

Section Familiarity with computer systems
Form SET 52

frafeiad o @ foraet Iugi Taenfea TR gt a1 ardeie Y i # fasar smar g2
Options :

1. ¥ T T

2. % HAH /U

3. % HARZHIBIH
4. # WISy (Stylus)

Question Number : 12 Question Id : 25498913740 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :

Key Value

Difficulty Level Medium

Item Year CPCT 2021

Topic Hardware

Sub Topic Output Devices

Micro Topic Printer (impact oor non-impact)
Objective Understanding

Section Familiarity with computer systems
Form SET 52

How many minimum number of cartridges does an inkjet colour printer have?
Options :



1. # Five
2. % Three
3.4 Two

4. % Four

Question Number : 12 Question Id : 25498913740 Question Type

Correct Marks : 1 Wrong Marks : 0
Question Key Details :

Key Value

Difficulty Level Medium

Item Year CPCT 2021

Topic Hardware

Sub Topic Output Devices

Micro Topic Printer (impact oor non-impact)
Objective Understanding

Section Familiarity with computer systems
Form SET 52

ZPHoic HeR Miex H GAdd fhd dIfcsl gid 82
Options :

1. % U

2. % dF

3./

4. % IR

Question Number : 13 Question Id : 2549897277 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Difficult

Item Year CPCT 2021

Topic Software

Sub Topic Operating Systems

: MCQ Option Shuffling : Yes Is Question Mandatory : No




Micro Topic Linux

Objective Knowledge

Section Familiarity with computer systems
Form SET 52

Which option is used with "Is" command to list all files including hidden files in Linux?
Options :

1.¥ -a

2. % x

3.% 4

4. % r

Question Number : 13 Question Id : 2549897277 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Difficult

Item Year CPCT 2021

Topic Software

Sub Topic Operating Systems

Micro Topic Linux

Objective Knowledge

Section Familiarity with computer systems
Form SET 52

o (Linux) &, f5th g5 wrgal afed it Bredl & Yeias dHRA & AU "Is" HHTe & 1Y o fadme &1 SudinT far S g2
Options :

1.¥ -a

2. % x

3. % -

4. % r

Question Number : 14 Question Id : 2549897858 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



Question Key Details :

Key Value

Difficulty Level Difficult

Item Year CPCT 2021

Topic Software

Sub Topic Proprietary Software

Micro Topic Microsoft Office

Objective Knowledge

Section Familiarity with computer systems
Form SET 52

From the given options, which window can be split into two panes in MS Access?
Options :

1. ¥ Design view

2. % Active

3. % Passive

4. % Procedure

Question Number : 14 Question Id : 2549897858 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Difficult

Item Year CPCT 2021

Topic Software

Sub Topic Proprietary Software

Micro Topic Microsoft Office

Objective Knowledge

Section Familiarity with computer systems
Form SET 52

%Q‘TQ fdehetl B § BT MS Access ﬁﬁ@ﬁﬁmﬁﬁWW%V
Options :

1. ¢ f&uga g
2. % Qldeq



3. % URG
4. % YIOOR

Question Number : 15 Question Id : 2549898684 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Difficult

Item Year CPCT 2021

Topic Software

Sub Topic Open Source Software

Micro Topic Open Office

Objective Understanding

Section Familiarity with computer systems
Form SET 52

31U SHTfFT e (OpenOfiice Cale) H TaRH ISEVEN(2.1) HT HT TITYE I

Options :
1. ®* FALSE
2. ¥ TRUE
3. ®* EVEN
4. % ODD

Question Number : 15 Question Id : 2549898684 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Difficult

Item Year CPCT 2021

Topic Software

Sub Topic Open Source Software
Micro Topic Open Office
Objective Understanding




Section Familiarity with computer systems

Form SET 52

What will be the output for the function ISEVEN(2.1) in an OpenOftice Calc?
Options :

1. # FALSE

2. ¥ TRUE

3. * EVEN

4. % ODD

Question Number : 16 Question Id : 2549899558 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Easy

Item Year CPCT 2021
Topic File Management
Sub Topic Printing

Micro Topic Setting up Printer
Objective Understanding
Section Knowledge of basic computer operations
Form SET 68
BankStatus Mock

First dot matrix printer was introduced by

Options :

1. #* Microsoft

2. % Epson

3. % Centronics

4. % Cannon

Question Number : 16 Question Id : 2549899558 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :




Key Value

Difficulty Level Easy

Item Year CPCT 2021

Topic File Management

Sub Topic Printing

Micro Topic Setting up Printer

Objective Understanding

Section Knowledge of basic computer operations
Form SET 68

BankStatus Mock

TeaTSlc Aft fier PRI fBar mar |

Options :

1. # W(Microsoft)
2. ® U (Epson)

3. ¢ YRR (Centronics)
4, ® W(Cannon)

Question Number : 17 Question Id : 25498913388 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
Question Key Details :

Key Value

Difficulty Level Easy

Item Year CPCT 2021

Topic File Management

Sub Topic Compressing files

Micro Topic Others

Objective Understanding

Section Knowledge of basic computer operations
Form SET 68

BankStatus Mock

A codec is a device or software that is used to or a digital media file, such as a video or song.

Options :

1. # store, transfer




2. % lock, unlock

3. ¥ compress, decompress

4. # delete, recover

Question Number : 17 Question Id : 25498913388 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :

Key Value

Difficulty Level Easy

Item Year CPCT 2021

Topic File Management

Sub Topic Compressing files

Micro Topic Others

Objective Understanding

Section Knowledge of basic computer operations
Form SET 68

BankStatus Mock

PIe® U [Sasy A1 A ddR ¢ o SudT fEforea Hifea wisd o difear ar iid & 3{yaT TR & o fpar A |
Options :

1. % ¥R, TFAHR

2. % Wb, 3D

3. ¢ qUifsd, srtifsd @ uw, feawuw)

4. % f&dle, RepaR

Question Number : 18 Question Id : 25498913940 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :

Key Value

Difficulty Level Easy

Item Year CPCT 2021

Topic Computer setup

Sub Topic Connecting to a network




Micro Topic Logging on and off to a network

Objective Knowledge

Section Knowledge of basic computer operations

Form SET 68

BankStatus Mock

Which of the following acts as an intermediary between client and server in case client requests from the server?
Options :

1. % Switches

2. % Router

3. # Firewall

4. ¥ Proxy server

Question Number : 18 Question Id : 25498913940 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Easy

Item Year CPCT 2021

Topic Computer setup

Sub Topic Connecting to a network

Micro Topic Logging on and off to a network
Objective Knowledge

Section Knowledge of basic computer operations
Form SET 68

BankStatus Mock

TR T FAEE 3RIY & AT H FaATEe 3R JaR & o AR & 0 H DI B Hdl 82

Options :

1. % &g

2. # 3N (Router)
3. % BRIRAI

4. YRl gaR




Question Number : 19 Question Id : 25498918432 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Easy

Item Year CPCT 2021

Topic System and Security Administration
Sub Topic Printing

Micro Topic Configuring default printer

Section Knowledge of basic computer operations
Form SET 68

BankStatus Mock

If you print two copies of a three-page document and you choose NOT to collate them then:
Options :

1. # Pages print in this order
2. ¥ pages print in this order
3. % Pages print in this order

4. % Pages print in this order

Question Number : 19 Question Id : 25498918432 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No

:1,2,1,2,3,3
:1,1,2,2,3,3
:1,2,3,1,2,3
:1,3,2,1,3,2

Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Easy

Item Year CPCT 2021

Topic System and Security Administration

Sub Topic Printing

Micro Topic Configuring default printer

Section Knowledge of basic computer operations
Form SET 68

BankStatus Mock

g 39 <fiF g8 & Gd1del &1 & Ufdferid Gigd HRd § SR 376 PIAC (collate) TR BT [dewed 81 Id © ar:

Options :




1. % gy Muifed pa A gfad sl 1,2, 1,2, 3,3
2. ¢ UN FEifbd pa E gfad gl 1, 1,2, 2, 3,3
3. % gy FEifbdpa g giaagin: 1,2,3,1,2,3
4. % gy Agifba s d gfad gt 1,3,2,1,3,2

Question Number : 20 Question Id : 25498918526 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Easy

Item Year CPCT 2021

Topic System and Security Administration
Sub Topic Preferences in an OS

Micro Topic Configuring OS

Section Knowledge of basic computer operations
Form SET 68

BankStatus Mock

Which of the following is NOT an operating system?

Options :

1. ®* MS DOS

2. % Windows 7

3. % Opera

4. # Linux

Question Number : 20 Question Id : 25498918526 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :

Key Value

Difficulty Level Easy

Item Year CPCT 2021

Topic System and Security Administration
Sub Topic Preferences in an OS




Micro Topic

Configuring OS

Section

Knowledge of basic computer operations

Form

SET 68

BankStatus

Mock

frafaRea § 3§ @F sfftrfen Rew 18 87
Options :

1. ¥ MS DOS

2. % Windows 7

3. % Opera

4. #® Linux

Question Number : 21 Question Id : 25498922639 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Easy

Item Year CPCT 2021

Topic Computer setup

Sub Topic Troubleshooting

Objective Understanding

Section Knowledge of basic computer operations
Form SET 68

BankStatus Mock

With respect to computer booting, BIOS stands for:

Options :

1. ¥ Basic input output system
2. % Binary input output system
3. # Binary in-out selection

4. % Basic input output storage

Question Number : 21 Question Id : 25498922639 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0




Question Key Details :

Key Value

Difficulty Level Easy

Item Year CPCT 2021
Topic Computer setup
Sub Topic Troubleshooting
Objective Understanding
Section Knowledge of basic computer operations
Form SET 68
BankStatus Mock

SR T & Y H, 3113311 TH. (BIOS) FT FT 34 i1 82
Options :

1. ¢ SR g1Yc 3{13cYc e (Basic input output system)
2. % g g1Yc 33cYc feq (Binary input output system)
3. % §IERI 39-3M13¢ YoM (Binary in-out selection)

4. % 9f®H 21YcC 33cYc TRl (Basic input output storage)

Question Number : 22 Question Id : 2549897355 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Medium

Item Year CPCT 2021

Topic File Management

Sub Topic File formats

Micro Topic Identifying and selecting suitable file formats and using them for transferring data
Objective Knowledge

Section Knowledge of basic computer operations
Form SET 68

BankStatus Mock

Which file format is used to save Assembler source code?
Options :

1. # .asc



2. % asm
3. ¥ .asmsc

4. % asmc

Question Number : 22 Question Id : 2549897355 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
Question Key Details :

Key Value

Difficulty Level Medium

Item Year CPCT 2021

Topic File Management

Sub Topic File formats

Micro Topic Identifying and selecting suitable file formats and using them for transferring data
Objective Knowledge

Section Knowledge of basic computer operations
Form SET 68

BankStatus Mock

SETFTR Y DTS DI Yoo b [T B Y WIsd BIHC BT SYINT [T STl 52
Options :

1. % .asc

2. % asm

3. % .asmsc

4. % asmc

Question Number : 23 Question Id : 2549898137 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Medium

Item Year CPCT 2021

Topic System and Security Administration
Sub Topic Data encryption




Micro Topic Keeping personal data private and secure
Objective Knowledge

Section Knowledge of basic computer operations
Form SET 68

BankStatus Mock

Authorized access is usually granted by entering your username and

Options :

1. # MAC address
2. % IP address

3. % password

4. ¥ gystem name

Question Number : 23 Question Id : 2549898137 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
Question Key Details :

Key Value

Difficulty Level Medium

Item Year CPCT 2021

Topic System and Security Administration

Sub Topic Data encryption

Micro Topic Keeping personal data private and secure
Objective Knowledge

Section Knowledge of basic computer operations
Form SET 68

BankStatus Mock

fIHd Ugd AR TR 31U TGN A (oK 1) 3R ST R et ]
Options :

1. % MAC UdT

2. % IPUdI

3. ¢ Ods
4. % g




Question Number : 24 Question Id : 2549898222 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Medium

Item Year CPCT 2021

Topic System and Security Administration
Sub Topic Virus protection

Micro Topic Others

Objective Knowledge

Section Knowledge of basic computer operations
Form SET 68

BankStatus Mock

Many websites use a to define their security and identity.

Options :

1. % code

2. ¥ certificate
3. ¥ program

4. % protocol

Question Number : 24 Question Id : 2549898222 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Medium

Item Year CPCT 2021

Topic System and Security Administration
Sub Topic Virus protection

Micro Topic Others

Objective Knowledge

Section Knowledge of basic computer operations
Form SET 68

BankStatus Mock




Hs AGAISC (U YR&T 3R TgaM B! TR H & fore HT SUTNT Bl B |

Options :

1. % I8

2. TGS (Iffthdse)
3. % O

4. * PTa

Question Number : 25 Question Id : 25498910756 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Medium

Item Year CPCT 2021

Topic Computer setup

Sub Topic Setting up a new device

Micro Topic Printer (impact oor non-impact)
Objective Knowledge

Section Knowledge of basic computer operations
Form SET 68

BankStatus Mock

A laser printer generates a totally black page. What is the cause?
Options :

1. ¥ No power to primary corona

2. # Malfunctioning imaging laser

3. % No power to transfer corona

4. # No level in toner cartridge

Question Number : 25 Question Id : 25498910756 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :

Key Value

Difficulty Level Medium




Item Year CPCT 2021

Topic Computer setup

Sub Topic Setting up a new device

Micro Topic Printer (impact oor non-impact)
Objective Knowledge

Section Knowledge of basic computer operations
Form SET 68

BankStatus Mock

AoR fUfer & g o @ o1 T 991 & HRUT, T el U fife foar simar g2

Options :

1. ¢ UIYTHS SR P ol Pis UraR gl
2. % AT ok TRIE g1
3. % PRI RIFIART B & iU Hls UlaR Tal

4, % TR PIICS J PIg R a1

Question Number : 26 Question Id : 25498910987 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Medium

Item Year CPCT 2021

Topic Computer setup

Sub Topic Connecting to a network
Micro Topic Others

Objective Knowledge

Section Knowledge of basic computer operations
Form SET 68

BankStatus Mock

A hybrid network topology is a combination of
Options :

1. #* Infinite

2. % Only five

3. % Only two

different basic network topologies.




4. % Two or more

Question Number : 26 Question Id : 25498910987 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Medium

Item Year CPCT 2021

Topic Computer setup

Sub Topic Connecting to a network
Micro Topic Others

Objective Knowledge

Section Knowledge of basic computer operations
Form SET 68

BankStatus Mock

U B1Sf9IS ead crraran, fafir Headh CIaraTeg BT YA g |
Options :

1. % 3Fd

2. % Had U
3. % Hadal
4. QT AP

Question Number : 27 Question Id : 25498913384 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Medium

Item Year CPCT 2021

Topic File Management
Sub Topic Compressing files
Micro Topic Others

Objective Understanding




Section Knowledge of basic computer operations

Form SET 68

BankStatus Mock

Which of the following number systems uses only two different symbols to represent data?
Options :

1. # Decimal

2. # Hexadecimal

3. ¥ Binary

4. # QOctal

Question Number : 27 Question Id : 25498913384 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Medium

Item Year CPCT 2021

Topic File Management

Sub Topic Compressing files

Micro Topic Others

Objective Understanding

Section Knowledge of basic computer operations
Form SET 68

BankStatus Mock

9 & T forg T ugfa # 3ies e #va & o Had &f fie Udiep! o1 IUTnT gid1 82
Options :

1. # QRIHId (Decimal)

2. % WIS MYRY (Hexadecimal)
3. ¢ fg3MTYRY (Binary)

4. % JVIYURT (Octal)

Question Number : 28 Question Id : 2549899512 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



Question Key Details :

Key Value

Difficulty Level Difficult

Item Year CPCT 2021
Topic File Management
Sub Topic Printing

Micro Topic Printing to a file
Objective Knowledge
Section Knowledge of basic computer operations
Form SET 68
BankStatus Mock

What is the length of the IPv4 address?

Options :

1. ¥ 32 bits

2. % 32 bytes

3. % 64 bits

4. * 64 bytes

Question Number : 28 Question Id : 2549899512 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Difficult

Item Year CPCT 2021
Topic File Management
Sub Topic Printing

Micro Topic Printing to a file
Objective Knowledge
Section Knowledge of basic computer operations
Form SET 68
BankStatus Mock

IPv4 Ud 1 daTs o1 gl 82

Options :




1. ¢ 32 facy

2. % 3291%cH
3. % o4 facy

4. % 64 91T

Question Number : 29 Question Id : 25498911281 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Difficult

Item Year CPCT 2021

Topic Computer setup
Sub Topic Audio controls
Micro Topic Audio conferencing
Objective Understanding
Section Knowledge of basic computer operations
Form SET 68

BankStatus Mock

Relationship between amplitude and frequency is represented by:
Options :

1. % phase-domain plot
2. # time-domain plot
3. ¥ frequency-domain plot

4. ¥ amplitude-domain plot

Question Number : 29 Question Id : 25498911281 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value
Difficulty Level Difficult

Item Year CPCT 2021
Topic Computer setup




Sub Topic Audio controls

Micro Topic Audio conferencing

Objective Understanding

Section Knowledge of basic computer operations
Form SET 68

BankStatus Mock

THIclieys 3R Wi & o Gy I o TR <=ifaT oirel 82

Options :

1. % Bol-SHHT Wi

2. % TRU-SIEA Wi

3. ¢ Wl Y-SIH- Wi
4. % TdcgS-Su- wic

Question Number : 30 Question Id : 25498924380 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :

Key Value

Difficulty Level Difficult

Item Year CPCT 2021

Topic System and Security Administration

Sub Topic Setting up of opertaing system

Micro Topic Others

Objective Understanding

Section Knowledge of basic computer operations
Form SET 68

BankStatus Mock

The ping command is not useful for the following:

Options :

1. % tracking and isolating network hardware and software problems.
2. % determining the status of the network and various foreign hosts.
3. # testing, measuring, and managing networks.

4. ¥ changing the passwords of the machines connected to the network.



Question Number : 30 Question Id : 25498924380 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Difficult

Item Year CPCT 2021

Topic System and Security Administration
Sub Topic Setting up of opertaing system
Micro Topic Others

Objective Understanding

Section Knowledge of basic computer operations
Form SET 68

BankStatus Mock

i wote faffed & famaes forg Suantt =t et 32

Options :

1. # Jcdd TSI 3R JIHEITR Pt JHETSN TR TR [ 3R I8 JYH B |
2. % Sas 3R Al fae=h gke & fufa & gFfda F1

3. % Jqgdi ol ofid, AU 3R UgY— B3|

4.« 92a% Y Jo! AR & UrIds & dga |

Question Number : 31 Question Id : 2549896686 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Easy

Item Year CPCT 2021

Topic Numeric Skills

Sub Topic Presentation Skills

Micro Topic Powerpoint Other Slides
Objective Knowledge

Section Proficiency in general IT skills
Form SET 52




MS PowerPoint 2007 H, ¥dT5S Alcx BHTS, oo e ¢a & 3idiid uran Sirar g2

Options :

1. * Insert
2. * Design
3. ¥ View

4. % Home

Question Number : 31 Question Id : 2549896686 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
Question Key Details :

Key Value

Difficulty Level Easy

Item Year CPCT 2021

Topic Numeric Skills

Sub Topic Presentation Skills

Micro Topic Powerpoint Other Slides
Objective Knowledge

Section Proficiency in general IT skills
Form SET 52

In MS PowerPoint 2007, slide sorter command is found under which ribbon tab?

Options :

1. ® Insert
2. % Design
3. ¥ View

4. % Home

Question Number : 32 Question Id : 2549897113 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value
Difficulty Level Easy

Item Year CPCT 2021




Topic Internet Skills

Sub Topic Online collaboration
Micro Topic Others

Objective Understanding

Section Proficiency in general IT skills
Form SET 52

MSN Te UHt 39 Ifa9 & o 9ad Ul fhads gR1 UG fovam T U
Options :

1. # Linux

2. % Unix

3. % Microsoft

4. % Ubuntu

Question Number : 32 Question Id : 2549897113 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :

Key Value

Difficulty Level Easy

Item Year CPCT 2021

Topic Internet Skills

Sub Topic Online collaboration
Micro Topic Others

Objective Understanding
Section Proficiency in general IT skills
Form SET 52

MSN is a Web service which was first provided by:

Options :

1. ®* Linux

2. # Unix

3. ¥ Microsoft
4. % Ubuntu



Question Number : 33 Question Id : 2549897369 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Easy

Item Year CPCT 2021

Topic Document Processing Skills
Sub Topic Document formatting
Micro Topic Others

Objective Application

Section Proficiency in general IT skills
Form SET 52

39 g & O forg 9 &1 SUANT b IS qxdTae H U§ I oS Tahd g7
Options :

1. ® Design

2. ¥ Insert

3. # Layout

4. % Format

Question Number : 33 Question Id : 2549897369 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Easy

Item Year CPCT 2021

Topic Document Processing Skills
Sub Topic Document formatting

Micro Topic Others

Objective Application

Section Proficiency in general IT skills
Form SET 52

Which of the following tabs is used to add a page number in word document?
Options :



1. # Design
2. ¥ Insert
3. % Layout

4. % Format

Question Number : 34 Question Id : 2549897380 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
Question Key Details :

Key Value

Difficulty Level Easy

Item Year CPCT 2021

Topic Document Processing Skills

Sub Topic Common word processing keyboard commands

Micro Topic Commands used by pressing Ctrl/ Shift/ Alt key and other keys
Objective Application

Section Proficiency in general IT skills

Form SET 52

What is the correct key / key combination to be used to delete one word to the left of the cursor point in MS Word?

Options :

1. ¥ CTRL+DELETE

2. % CTRL+BACKSPACE
3. % DELETE

4. ¥ BACKSPACE

Question Number : 34 Question Id : 2549897380 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Easy

Item Year CPCT 2021

Topic Document Processing Skills

Sub Topic Common word processing keyboard commands




Micro Topic Commands used by pressing Ctrl/ Shift/ Alt key and other keys
Objective Application

Section Proficiency in general IT skills

Form SET 52

MS Word & HR foig & aT3 3R T eg & e o foT Tt grolt / ol Tator a1 82

Options :

1. ®# CTRL+DELETE

2. ¥ CTRL+BACKSPACE
3. ¥ DELETE

4. ¥ BACKSPACE

Question Number : 35 Question Id : 2549897397 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Easy

Item Year CPCT 2021

Topic Document Processing Skills
Sub Topic Miscellaneous Document Processing Skills
Micro Topic Others

Objective Application

Section Proficiency in general IT skills
Form SET 52

Next footnote option is available in which menu tab of MS Word 2016?

Options :

1. # TABLE

2. % FORMAT

3. % INSERT

4. ¥ REFERENCES

Question Number : 35 Question Id : 2549897397 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



Question Key Details :

Key Value

Difficulty Level Easy

Item Year CPCT 2021

Topic Document Processing Skills
Sub Topic Miscellaneous Document Processing Skills
Micro Topic Others

Objective Application

Section Proficiency in general IT skills
Form SET 52

MS Word 2016 & fardf fﬁ[%a o STl W:h_(f (next footnote) fddhed IUeTsY 8?
Options :

1. ®* TABLE

2. ® FORMAT

3. ¥ INSERT

4. ¥ REFERENCES

Question Number : 36 Question Id : 2549897478 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :

Key Value

Difficulty Level Easy

Item Year CPCT 2021

Topic Numeric Skills

Sub Topic Presentation Skills

Micro Topic Others

Objective Application

Section Proficiency in general IT skills
Form SET 52

What is the key combination to change the pointer to a pen in a slide show mode in MS PowerPoint?
Options :

1. % ALT+P

2. % CTRL+P



3. # CTRL+A
4. %= ALT+A

Question Number : 36 Question Id : 2549897478 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
Question Key Details :

Key Value

Difficulty Level Easy

Item Year CPCT 2021

Topic Numeric Skills

Sub Topic Presentation Skills

Micro Topic Others

Objective Application

Section Proficiency in general IT skills
Form SET 52

MS PowerPointﬁW@%ﬁWﬁhﬁWﬁ%WﬁWW%?

Options :

1. ¥ ALT+P
2. % CTRL+P
3. % CTRL+A
4. % ALT+A

Question Number : 37 Question Id : 2549898054 Question Type

Correct Marks : 1 Wrong Marks : 0
Question Key Details :

Key Value

Difficulty Level Easy

Item Year CPCT 2021

Topic Numeric Skills

Sub Topic Graphs

Micro Topic Creating graphs like bar, pie, line, etc from the data provided in a table
Objective Knowledge

Section Proficiency in general IT skills

: MCQ Option Shuffling : Yes Is Question Mandatory : No




Form SET 52

Which of the following is NOT a variant of the Pie chart?
Options :

1. # Doughnut

2. % Line

3. % Spie

4. # Ring

Question Number : 37 Question Id : 2549898054 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :

Key Value

Difficulty Level Easy

Item Year CPCT 2021

Topic Numeric Skills

Sub Topic Graphs

Micro Topic Creating graphs like bar, pie, line, etc from the data provided in a table
Objective Knowledge

Section Proficiency in general IT skills
Form SET 52

fFafiiRed # ¥ 19 91 UTs 1¢ &1 UBR 81 52

Options :

1. % SMc

2. % g

3. % Wiy

4. % 1

Question Number : 38 Question Id : 2549898063 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :

Key Value

Difficulty Level Easy




Item Year CPCT 2021

Topic Numeric Skills

Sub Topic Graphs

Micro Topic Creating graphs like bar, pie, line, etc from the data provided in a table
Objective Knowledge

Section Proficiency in general IT skills

Form SET 52

To represent the information in the same order on each bar chart is useful in MS Excel.
Options :

1. # doughnut

2. # line

3. % radar

4. ¥ stacked

Question Number : 38 Question Id : 2549898063 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Easy

Item Year CPCT 2021

Topic Numeric Skills

Sub Topic Graphs

Micro Topic Creating graphs like bar, pie, line, etc from the data provided in a table
Objective Knowledge

Section Proficiency in general IT skills

Form SET 52

TdH 9R T T 51 hH H YT (FTBHRM) B! I B b T8 MS Excel | e IUART BT ]

Options :
|. % SMC
2. % ol
3. ¥ YIS
4.V WIS




Question Number : 39 Question Id : 25498919153 Question Type : MCQ Option Shuffling

Correct Marks : 1 Wrong Marks : 0

: Yes Is Question Mandatory : No

Question Key Details :

Key Value

Difficulty Level Easy

Item Year CPCT 2021

Topic General IT Skills

Sub Topic Mailmerge

Micro Topic Creating template for letters, envelopes, etc
Objective Knowledge

Section Proficiency in general IT skills

Form SET 52

When you click on envelopes icon in create group of Mailing tab in MS Word 2016,

Options :
1. * Envelopes
2. % Labels

3. % Envelopes and Labels

4. * Create envelope

Question Number : 39 Question Id : 25498919153 Question Type : MCQ Option Shuffling

Correct Marks : 1 Wrong Marks : 0

dialogue box will be opened.

: Yes Is Question Mandatory : No

Question Key Details :

Key Value

Difficulty Level Easy

Item Year CPCT 2021

Topic General IT Skills

Sub Topic Mailmerge

Micro Topic Creating template for letters, envelopes, etc
Objective Knowledge

Section Proficiency in general IT skills

Form SET 52

ST 31T MS Word 2016 H fohTe U 3ifth AfeiT &8 T T (envelope) & 3MSH WR fadds &1, dt aTe (STIanT) Siad g




ST

Options :

1. # Envelopes

2. % Labels

3. % Envelopes and Labels

4. # Create envelope

Question Number : 40 Question Id : 2549896389 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :

Key Value

Difficulty Level Medium

Item Year CPCT 2021

Topic Internet Skills

Sub Topic Search engine

Micro Topic Others

Objective Knowledge

Section Proficiency in general IT skills
Form SET 52

Which of the following is a popular Web search engine used worldwide?
Options :

1. # Intel

2. ¥ Google

3. % Apple

4. % WWW

Question Number : 40 Question Id : 2549896389 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Question Key Details :
Key Value
Difficulty Level Medium

Item Year CPCT 2021




Topic Internet Skills

Sub Topic Search engine

Micro Topic Others

Objective Knowledge

Section Proficiency in general IT skills
Form SET 52

9 T QDI A1 TP B0 39 Il S0l gl HR T SUIRT 5T STl 82
Options :

1. %* Intel

2. ¥ Google

3. % Apple

4. % WWW

Question Number : 41 Question Id : 2549897104 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :

Key Value

Difficulty Level Medium

Item Year CPCT 2021

Topic Internet Skills
Sub Topic Internet Services
Micro Topic Email

Objective Knowledge
Section Proficiency in general IT skills
Form SET 52

In Gmail, tab is used for notifications of bills and statements.
Options :

1. ¥ updates

2. % promotions
3. # forums

4. % primary



Question Number : 41 Question Id : 2549897104 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Medium

Item Year CPCT 2021

Topic Internet Skills

Sub Topic Internet Services

Micro Topic Email

Objective Knowledge

Section Proficiency in general IT skills
Form SET 52

Gmail &, 2 &1 YA fall 3R Hu Bt HfRgEATst & forg far Srar g

Options :

1. ¥ 3fEA (3180)
2. % faqu= (THRE)
3. % BRY

4. % UIYfHH

Question Number : 42 Question Id : 2549898032 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
Question Key Details :

Key Value

Difficulty Level Medium

Item Year CPCT 2021

Topic Numeric Skills

Sub Topic Graphs

Micro Topic Creating graphs like bar, pie, line, etc from the data provided in a table
Objective Knowledge

Section Proficiency in general IT skills

Form SET 52

Which of the following is NOT a Line chart?
Options :




1. ¥ Radar

2. % Stacked

3. % 100% Stacked
4. % 3.D

Question Number : 42 Question Id : 2549898032 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
Question Key Details :

Key Value

Difficulty Level Medium

Item Year CPCT 2021

Topic Numeric Skills

Sub Topic Graphs

Micro Topic Creating graphs like bar, pie, line, etc from the data provided in a table
Objective Knowledge

Section Proficiency in general IT skills
Form SET 52

fFafafed o 9 &9 91 fawed drg 91c 718t o7

Options :

1. ¥ ISR

2. % WIS
3. % 100% KIS

4. % 3-D

Question Number : 43 Question Id : 25498910468 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Medium

Item Year CPCT 2021

Topic Document Processing Skills
Sub Topic Editing a document




Micro Topic Font type, font size

Objective Knowledge

Section Proficiency in general IT skills
Form SET 52

We can apply different change case using Shift+F3 to selected paragraph.
Options :

1. ® one

2. % two

3. ¥ three

4. % four

Question Number : 43 Question Id : 25498910468 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Medium

Item Year CPCT 2021

Topic Document Processing Skills
Sub Topic Editing a document

Micro Topic Font type, font size

Objective Knowledge

Section Proficiency in general IT skills
Form SET 52

D! T URTIE H Shift+F3 HT YA B iy ufkad 9 AR R IHhd & |
Options :

1. % U

2. % Q)

3.¢ dH

4, % TR

Question Number : 44 Question Id : 25498910529 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



Question Key Details :

Key Value

Difficulty Level Medium

Item Year CPCT 2021

Topic Document Processing Skills
Sub Topic Document Layout

Micro Topic Sizes

Objective Knowledge

Section Proficiency in general IT skills
Form SET 52

Deepu doesn't want to use any one of the standard paper sizes on the "size" menu to print an MS Word document. In that case, he has to click
'More Paper Sizes' options, which is at the of the Size menu.

Options :

1. ¥ bottom
2. % top

3. % left

4. ® right

Question Number : 44 Question Id : 25498910529 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Medium

Item Year CPCT 2021

Topic Document Processing Skills
Sub Topic Document Layout

Micro Topic Sizes

Objective Knowledge

Section Proficiency in general IT skills
Form SET 52

&g MS Word STl Jfed HA o o0 "HIZSl" B (Size Menu) TR ol Hff AT TR MTHR T SUTNT Ta1 1 d18d & | 39 RUfA 7,
39 "More Paper Sizes' UX fdeTep A1 I Sfl Trewl ﬁT-‘L(Size Menu) & % I
Options :



1. ¢ TR &I 3R
2. % JMPI AR
3. % FU DI 3R
4. % U PHI 3R

Question Number : 45 Question Id : 25498912487 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Medium

Item Year CPCT 2021

Topic Document Processing Skills
Sub Topic Document formatting
Micro Topic Header and footer
Objective Knowledge

Section Proficiency in general IT skills
Form SET 52

What is the difference between header & footer?

Options :

1. # Header puts an appearance at the top while footer gives an information about how the document looks.
2. # Footer is placed at top and header at top.
3. % Header gives information about appearance at every page while footer helps how the page looks.

4. ¥ Header is placed at top wile footer is placed at bottom.

Question Number : 45 Question Id : 25498912487 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :

Key Value

Difficulty Level Medium

Item Year CPCT 2021

Topic Document Processing Skills
Sub Topic Document formatting




Micro Topic Header and footer

Objective Knowledge

Section Proficiency in general IT skills
Form SET 52

g 3R Pex H 1 3R 82

Options :

1. % TR IWR TR T ¢ el PR Siagie & IR H THGR] 31 ¢ b I8 S fexars |

2. % HeR DI BHUR IWT 11T § 3R 38% SHUR W1 Sl ]

3. % BSR IS U TR JURKA & IR T THSHRI Gl § Saih HeR, Uol bl fG@dl & 39 Feradl ol 6|
4. ¢ ISR B SR W AT § Tafh Fex DI i [T A1 g |

Question Number : 46 Question Id : 25498913288 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value
Difficulty Level Medium

Item Year CPCT 2021
Topic Numeric Skills
Sub Topic Macros

Micro Topic Others
Objective Knowledge
Section Proficiency in general IT skills
Form SET 52

How to enable macros in MS Excel 2000 and 2003?

Options :

1. #® In Microsoft Excel navigate to File > Options > Trust Center > Trust Center Settings

2. % (Click the Microsoft Office Button > Access Options > Trust Center > Trust Center Settings > Macro Settings
3. ¥ In Microsoft Excel navigate to Tools tab > Macro > Security

4. ® Click the Microsoft Office Button > Excel Options > Security

Question Number : 46 Question Id : 25498913288 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



Question Key Details :

Key Value
Difficulty Level Medium

Item Year CPCT 2021
Topic Numeric Skills
Sub Topic Macros

Micro Topic Others
Objective Knowledge
Section Proficiency in general IT skills
Form SET 52

MS Excel 2000 3R 2003 T HehISl b1 H T&H P2

Options :

1. # In Microsoft Excel navigate to File > Options > Trust Center > Trust Center Settings

2. # Click the Microsoft Office Button > Access Options > Trust Center > Trust Center Settings > Macro Settings
3. % In Microsoft Excel navigate to Tools tab > Macro > Security

4. # Click the Microsoft Office Button > Excel Options > Security

Question Number : 47 Question Id : 25498913292 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :

Key Value

Difficulty Level Medium

Item Year CPCT 2021

Topic Numeric Skills

Sub Topic Macros

Micro Topic Others

Objective Knowledge

Section Proficiency in general IT skills
Form SET 52

Which of the following functions CANNOT be achieved by writing macros in MS Excel?
Options :

1. ¥ Compression of data and text

2. % Apply style and formatting



3. % Create entirely new documents
4. ¥ Manipulate data and text

Question Number : 47 Question Id : 25498913292 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
Question Key Details :

Key Value

Difficulty Level Medium

Item Year CPCT 2021

Topic Numeric Skills

Sub Topic Macros

Micro Topic Others

Objective Knowledge

Section Proficiency in general IT skills
Form SET 52

MS Excel & ThIol forga: 9 & T &9 91 thaR YTt A8} fohar ol Ihdl 22

Options :

1. ¢ 3T 3R TRE HT YUIs (HHTF)

2. % et (Style) 3R TReTT (Formatting) ¢I] T

3. % gUi &Y Y U Gxdrdel M
4. % 32T SR TRE BT FHAT

Question Number : 48 Question Id : 25498924864 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Medium

Item Year CPCT 2021

Topic Numeric Skills
Sub Topic Presentation Skills
Micro Topic Pivot tables
Objective Application




Section Proficiency in general IT skills

Form SET 52

What keys do you need to press on the key board to insert a $?
Options :

1. ® Ctrl+4

2. ¥ Shift+4

3. % Alt+4

4. = Enter+4

Question Number : 48 Question Id : 25498924864 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Medium

Item Year CPCT 2021

Topic Numeric Skills

Sub Topic Presentation Skills
Micro Topic Pivot tables

Objective Application

Section Proficiency in general IT skills
Form SET 52

$ BT & foTT SIS Hiale IR o HIoTal DI Ga B SHTARTDHT 82
Options :

1. ® Ctrl+4

2. ¥ Shift+4

3. % Alt+4

4. * Enter+4

Question Number : 49 Question Id : 25498911489 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :

Key Value




Difficulty Level Difficult

Item Year CPCT 2021

Topic Document Processing Skills

Sub Topic Editing a document

Micro Topic Antivirus software

Objective Understanding

Section Proficiency in general IT skills

Form SET 52

In the Find and Replace feature of MS Word, "Find What" is the word to be searched, and " " is the word for replacement.
Options :

1. ¥ Replace with
2. # Replace for
3. % Change with
4. # Change for

Question Number : 49 Question Id : 25498911489 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Difficult

Item Year CPCT 2021

Topic Document Processing Skills
Sub Topic Editing a document

Micro Topic Antivirus software

Objective Understanding

Section Proficiency in general IT skills
Form SET 52

MS Word & Find and Replace AR (B1=R) H, "Find What" XTeg WISl ST aTa ¥eg 8, 3R " " GfRITO & T ¥ B |
Options :

1. ¥ Replace with

2. # Replace for

3. ¥ Change with

4. # Change for



Question Number : 50 Question Id : 25498911843 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Difficult

Item Year CPCT 2021

Topic Document Processing Skills
Sub Topic Document Layout

Micro Topic Spacing

Objective Knowledge

Section Proficiency in general IT skills
Form SET 52

How many number of controls are there in Indent and Spacing tab in MS Word?
Options :

1. % 1

2. % 2

3.3

4. % 4

Question Number : 50 Question Id : 25498911843 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Difficult

Item Year CPCT 2021

Topic Document Processing Skills
Sub Topic Document Layout

Micro Topic Spacing

Objective Knowledge

Section Proficiency in general IT skills
Form SET 52

MS Word H §8¢ 3R TR ¢a # fabe ez g1d 82



Options :
1. %1
2. %2
3.3
4. % 4

Question Number : 51 Question Id : 25498918936 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Difficult

Item Year CPCT 2021

Topic Numeric Skills

Sub Topic Common keyboard commands for spreadsheets
Micro Topic Commands used by pressing Ctrl/ Shift/ Alt key and other keys
Objective Knowledge

Section Proficiency in general IT skills

Form SET 52

How will you turn on sticky keys in Windows 7 or Vista?

Options :

1. # Press shift button for 8 seconds
2. % Press shift button for 5 times in a row

3. # Presses NumLock for 5 seconds
4. ¥ Using Tab+Shift

Question Number : 51 Question Id : 25498918936 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value
Difficulty Level Difficult

Item Year CPCT 2021
Topic Numeric Skills




Sub Topic Common keyboard commands for spreadsheets

Micro Topic Commands used by pressing Ctrl/ Shift/ Alt key and other keys
Objective Knowledge

Section Proficiency in general IT skills

Form SET 52

Windows 7 or Vista & 310 et gmﬂ G| dlq\d&.‘\l?

Options :

1. % fR[UC (shift) ¢ @I 8 Ybe o o gamyg
2. ¢ TRIUC (shift) ¢ AR 5 IR AT

3. % NumLock &I 5 4dhs & [olT Ga

4. ® Tab+Shift BT T P B

Question Number : 52 Question Id : 25498918959 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
Question Key Details :

Key Value

Difficulty Level Difficult

Item Year CPCT 2021

Topic Numeric Skills

Sub Topic Common keyboard commands for spreadsheets

Micro Topic Commands used by pressing Ctrl/ Shift/ Alt key and other keys
Objective Knowledge

Section Proficiency in general IT skills

Form SET 52

Which key combination is used to open the system properties in Windows?

Options :

1. % WINDOWS KEY+F

2. % WINDOWS KEY+E

3. % WINDOWS KEY+PAUSE/BREAK
4. % WINDOWS KEY+R

Question Number : 52 Question Id : 25498918959 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No




Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Difficult

Item Year CPCT 2021

Topic Numeric Skills

Sub Topic Common keyboard commands for spreadsheets
Micro Topic Commands used by pressing Ctrl/ Shift/ Alt key and other keys
Objective Knowledge

Section Proficiency in general IT skills

Form SET 52

Windows & 31T Ried UTac] &1 ford ol TTor &1 TNT & & Q@Id Fabhd 67

Options :
1. ¥ WINDOWS KEY+F
2. % WINDOWS KEY+E

3. % WINDOWS KEY+PAUSE/BREAK

4. % WINDOWS KEY+R

Section Id :

Section Number :
Section type :
Mandatory or Optional :
Number of Questions :

Number of Questions to be attempted :

Section Marks :

Enable Mark as Answered Mark for Review and Clear Response :

Sub-Section Number :
Sub-Section Id :
Question Shuffling Allowed :

READING COMPREHENSION

2549894308
2

Online
Mandatory

1

1

5

Yes

1
2549894349
Yes




Question Id : 25498920953 Question Type : COMPREHENSION Sub Question Shuffling Allowed : Yes Group Comprehension
Questions : No

Question Numbers : (53 to 57)
Question Key Details :

Key Value

Item Year CPCT 2021

Topic Reading Comprehension
Form SET 68

BankStatus Mock

Birds and ecosystem

Birds are a special kind of animal species. They have specific characteristics that are common to all of them. All of them have feathers, wings,
two legs, they lay eggs, and are warm-blooded animals belonging to the class Aves. They are an important part of our ecosystem.

Birds are of different sizes and colours. They could be small - as much as 2 inches e.g. the Bee hummingbird or as big as 2.75 meters like an
Ostrich. Scientists are of the opinion that birds are as old as 160 million years.

Some birds cannot fly. The penguin is one such bird. Certain birds like parrots and crows are known to be highly intelligent. The way certain
birds build their intricately woven and safe nests to preserve their eggs indicates that they have many skills.

Birds are very closely connected with the environment. They come to know about the change in weather conditions before humans can predict it.
The presence of a peacock symbolizes rain and good weather while the presence of owls, bats and vultures is said to indicate a bad, unpleasant
weather in an area. Birds are very social. Most communication among them happens through sounds that they make or singing that they do. They
live in flocks, hunt, breed cooperatively and participate in social behaviours.

Many birds are extinct due to hunting. Even birds that live in water like ducks etc. have seen a drastic fall in numbers because of the polluted
lakes and rivers. Birds living close to the river banks consume polluted water and die.

As birds are vital for the balance of this ecosystem we must take adequate steps to preserve them by providing them with safe and clean habitat
for survival.

Sub questions

Question Number : 53 Question Id : 25498920954 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Question Key Details :
Key Value
Item Year CPCT 2021

Topic Reading Comprehension




Form

SET 68

BankStatus

Mock

According to the passage, which of the following characteristics are common to all birds?

Options :

1. ¥ They all have wings and feathers.

2. % They are of different shapes and sizes.
3. #® They are important for the ecosystem.

4. % They are our friends.

Question Number : 54 Question Id : 25498920955 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Item Year CPCT 2021

Topic Reading Comprehension
Form SET 68

BankStatus Mock

According to the passage, which of the following statements is NOT TRUE?

Options :

1. % Penguins cannot fly.

2. % Parrots are intelligent birds.

3. ¥ Bee hummingbird is very small.

4. % Crows indicate weather.

Question Number : 55 Question Id : 25498920956 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Item Year CPCT 2021

Topic Reading Comprehension
Form SET 68

BankStatus Mock

Birds communicate with each other by




Options :

1. # dancing in the rain

2. % making sounds and singing
3. # telling about weather

4. % staying together in flocks

Question Number : 56 Question Id : 25498920957 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Item Year CPCT 2021

Topic Reading Comprehension
Form SET 68

BankStatus Mock

What is important for the survival of the birds?
Options :

1. ¥ A safe and clean habitat

2. % A balanced ecosystem

3. # Clean lakes and rivers

4. % Rain and good weather

Question Number : 57 Question Id : 25498920958 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Item Year CPCT 2021

Topic Reading Comprehension
Form SET 68

BankStatus Mock

The ‘many skills’ that the writer is talking about refers to the birds’ ability to
Options :
1. # predict the weather



2. * live in groups
3. * sing together

4. ¥ making intricate nests

Question Id : 25498920953 Question Type : COMPREHENSION Sub Question Shuffling Allowed : Yes Group Comprehension
Questions : No

Question Numbers : (53 to 57)

Question Key Details :

Key Value

Item Year CPCT 2021

Topic Reading Comprehension
Form SET 68

BankStatus Mock

el 3R urifRufares o

gl ARy UepR ) Uy yeifaai § 1 3! ARy fAdvan S ST I S R em 81 e $ ie, IR, A 3 AT, iR g @
T T G 9T AR 81d & | 3 gHR UIRfRUTes! o o1 T Agayuf ifwa g
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A & oY o= Sifed g gU SR QR Tiaa &1 FHfur axd §, S99 I8 Jdbd Had & i 377% U &8 DI 6|
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Sub questions




Question Number : 53 Question Id : 25498920954 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Item Year CPCT 2021

Topic Reading Comprehension
Form SET 68

BankStatus Mock

TG & AR, FafiRad o 9 o1 Ht faxivard gt ufar & foe amma 82
Options :

1. ¥ 9t F T dE B

2. % g fafts 3pfa SR SMPR F Bl & |
3. % g UTRfRUfae! dF & forg weayuf § |
4. % JEARIRA G|

Question Number : 54 Question Id : 25498920955 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Item Year CPCT 2021

Topic Reading Comprehension
Form SET 68

BankStatus Mock

TG P AR, FEREd & ¥ o9 1 By I T8 22

Options :

1. * U7 3§ el 9ohd g

2. % AId gfgar el |1

3. % OYARI gHTeS dgd B |
4.« B AIGH BT Gbd ad B

Question Number : 55 Question Id : 25498920956 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



Question Key Details :

Key Value

Item Year CPCT 2021

Topic Reading Comprehension
Form SET 68

BankStatus Mock

geft Ueh-geR & 1Y fhy g ¥ Hare HRd 82
Options :

1. % aN B TA R P |

2. ¢ 3TATS 3R T R & |

3. % O & IR & U g P §dT b |

4. % S H TS AYE D

Question Number : 56 Question Id : 25498920957 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Item Year CPCT 2021

Topic Reading Comprehension
Form SET 68

BankStatus Mock

gférat o eifda & fore o Heaguf 82

Options :

1. ¢ RI&T 3R AT SMa
2. % Tferd uiRfRufae @
3. % 95 Sid 3R Afei

4. % IR 3R 33T AGH

Question Number : 57 Question Id : 25498920958 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
Question Key Details :

Key

Value




Item Year CPCT 2021

Topic Reading Comprehension

Form SET 68

BankStatus Mock

TGS TG UlEl & g DRI b IR H &1d BT & Al 98 [y Harid bRl o7
Options :

1. % HrgH o1 Hiasgarolt el

2. % qHEI H G

3. % U 1Y T

4. ¢ Uil gRI Sifed grad ST

QUANTITATIVE APTITUDE
Section Id : 2549894309
Section Number : 3
Section type : Online
Mandatory or Optional : Mandatory
Number of Questions : 6
Number of Questions to be attempted : 6
Section Marks : 6
Enable Mark as Answered Mark for Review and Clear Response : Yes
Sub-Section Number : 1
Sub-Section Id : 2549894350
Question Shuffling Allowed : Yes

Question Number : 58 Question Id : 25498914246 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :

Key Value
Difficulty Level Easy
Item Year CPCT 2021

Topic Number System




Sub Topic BODMAS Rule
Objective Understanding
Form SET 69
BankStatus Mock

What approximate value should come in place of the question mark (?) in the following expression?

96.996 x 9.669 + 0.96
Options :
1. % 860
2. % 870
3. % 1020
4.+ 940

Question Number : 58 Question Id : 25498914246 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value
Difficulty Level Easy

Item Year CPCT 2021
Topic Number System
Sub Topic BODMAS Rule
Objective Understanding
Form SET 69
BankStatus Mock

frafafad e o uy forg (2) & R W a9 1 ST

96.996 % 9.669 + 0.96
Options :
1. % 860
2. % 870
3. % 1020
4. % 940




Question Number : 59 Question Id : 25498929335 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Easy

Item Year CPCT 2021

Topic Arithmetical Progression
Sub Topic Arithmetic reasoning
Objective Application

Form SET 69

BankStatus Mock

L.

Options :

1. % o

2. ¥ o

3. % lo.

4. % |o

Question Number : 59 Question Id : 25498929335 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Easy

Item Year CPCT 2021

Topic Arithmetical Progression
Sub Topic Arithmetic reasoning
Objective Application

Form SET 69

BankStatus Mock

L.




Options :
1. %

L
2.9 lo

3. % [

4, R o,

Question Number : 60 Question Id : 25498928950 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value
Difficulty Level Medium

Item Year CPCT 2021
Topic Elementry Stats and Prob.
Sub Topic Graphs
Objective Understanding
Form SET 69
BankStatus Mock

A

Options :

1. % Lo

2. % o

3.9 e

4. # |o.

Question Number : 60 Question Id : 25498928950 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



Question Key Details :

Key Value
Difficulty Level Medium

Item Year CPCT 2021
Topic Elementry Stats and Prob.
Sub Topic Graphs
Objective Understanding
Form SET 69
BankStatus Mock

A

Options :

1. % le

2. % e

3. ol

4. ® lo.

Question Number : 61 Question Id : 25498929434 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value
Difficulty Level Medium

Item Year CPCT 2021
Topic Trigononometry
Sub Topic Trigononometry
Objective Understanding
Form SET 69
BankStatus Mock

A

Options :

1. % [




2. % e
(e

4, ¥ e

Question Number : 61 Question Id : 25498929434 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value
Difficulty Level Medium

Item Year CPCT 2021
Topic Trigononometry
Sub Topic Trigononometry
Objective Understanding
Form SET 69
BankStatus Mock

L.

Options :

1. % o

2. % [

3. % lo.

4. ¥ o

Question Number : 62 Question Id : 25498928910 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :

|Key |Value



Difficulty Level Difficult
Item Year CPCT 2021
Topic Arithmetic
Sub Topic Arithmetic reasoning
Objective Knowledge
Form SET 69
BankStatus Mock
L.
Options :

L
1. #

L
2. %

L
3. %

L.
4.

Question Number : 62 Question Id : 25498928910 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Difficult

Item Year CPCT 2021

Topic Arithmetic

Sub Topic Arithmetic reasoning
Objective Knowledge

Form SET 69

BankStatus Mock

L.

Options :



2. % |
3. % e

4. ¥ |o

Question Number : 63 Question Id : 25498929358 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :

Key Value
Difficulty Level Difficult
Item Year CPCT 2021
Topic Geometry
Sub Topic Geometry
Objective Application
Form SET 69
BankStatus Mock

A

Options :

1. % le

2. % e

3. ol

4. ® lo.

Question Number : 63 Question Id : 25498929358 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :




Key Value
Difficulty Level Difficult
Item Year CPCT 2021
Topic Geometry
Sub Topic Geometry
Objective Application
Form SET 69
BankStatus Mock
L.
Options :
1. % [
2. % |,
3. ¥ e
4, % |od
GENERAL MENTAL ABILITY AND REASONING
Section Id : 2549894310
Section Number : 4
Section type : Online
Mandatory or Optional : Mandatory
Number of Questions : 6
Number of Questions to be attempted : 6
Section Marks : 6
Enable Mark as Answered Mark for Review and Clear Response : Yes
Sub-Section Number : 1
Sub-Section Id : 2549894351
Question Shuffling Allowed : Yes




Question Number : 64 Question Id : 25498910049 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Easy

Item Year CPCT 2021

Topic Logical Reasoning
Sub Topic Alphabet Test
Objective Application

Form SET 68
BankStatus Mock

Which of the following words will come third if all of them are arranged alphabetically as in a dictionary?
Options :

1. # Gradin

2. % QGradient
3. % (Qraduate

4. ¥ Grading

Question Number : 64 Question Id : 25498910049 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Easy

Item Year CPCT 2021

Topic Logical Reasoning
Sub Topic Alphabet Test
Objective Application

Form SET 68
BankStatus Mock

IR Ueg 8 T § 1 Afe T Wsal DI T TG - & SUR JUITIHH H Hafeyd fohal oifd &, df dias I IR $IH A7 Xeq AT
Options :

1. # Gradin

2. % QGradient




3. # QGraduate
4. % Grading

Question Number : 65 Question Id : 25498919607 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Easy

Item Year CPCT 2021
Topic Verbal Reasoning
Sub Topic Best description
Objective Knowledge

Form SET 68
BankStatus Mock

Select the alternative with the most appropriate description about these three words.

Press : Television : Cinema

Options :

1. ¥ They are means of entertainment.
2. % They are means of mass media.
3. # They give worldwide news.

4. % All are public undertakings.

Question Number : 65 Question Id : 25498919607 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Easy

Item Year CPCT 2021
Topic Verbal Reasoning
Sub Topic Best description
Objective Knowledge

Form SET 68




|BankStatus |Mock

9 A WUsal b oy H Ia Ifd faaun arat fased o1 99— He |
agé?ﬁﬁﬁqﬁlﬁm

Options :

1. # 3 TR & e g

2. ¢ A HifSTT & WY |
3. % JEAT R P TR A 5|
4. % g ufdtp SigefHT Bl

Question Number : 66 Question Id : 25498910248 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Medium

Item Year CPCT 2021
Topic Logical Reasoning
Sub Topic Analogy
Objective Knowledge
Form SET 68
BankStatus Mock

Loiter is related to Dwindle in the same way as Impugn is related to:
Options :

1. ¥ Challenge

2. % Gamble

3. #* Confiscate

4. % Revenge

Question Number : 66 Question Id : 25498910248 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :

Key Value




Difficulty Level Medium

Item Year CPCT 2021

Topic Logical Reasoning
Sub Topic Analogy
Objective Knowledge

Form SET 68
BankStatus Mock

iR Ie BT gadl 81 U dg! YaY g SNl aIe-fadrg &R &l Jel
Options :

1. ¢ AT &

2. ® 3T WA

3. % 3RO DA

4. % qear o

Question Number : 67 Question Id : 25498941127 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Medium

Item Year CPCT 2021

Topic Logical Reasoning
Sub Topic Alpha Numeric Series
Form SET 68

BankStatus Mock

Instruction: Study the following letter-number sequence to answer the question below.
E&GBDM4NKH2ACZSV3F1JLOQSPR

Question: If every third letter/number starting from the right replaces successive days of the week starting from Monday, then which letter will
replace Thursday?

Options :
1. % A
2. % F



3.¥S
4. % Z

Question Number : 67 Question Id : 25498941127 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :

Key Value

Difficulty Level Medium

Item Year CPCT 2021

Topic Logical Reasoning
Sub Topic Alpha Numeric Series
Form SET 68

BankStatus Mock

3SR : =i faU T Uy 1 IR &7 & fore Fafafad sieR-TReam S| &1 3{eqg de:

E&GBDM4NKH2ACZSV3FIJLOQSPR

Ty - IS A SR T T R $1&R / W& AHaR ¥ YR 84 a1 Twig & Tt feml &1 AT 0 § ufaei1iid &l g, O gefdar
DT DI T &R UTrRATIUT B2

Options :
1. % A
2. % F
3.8
4. % 7

Question Number : 68 Question Id : 25498919650 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Question Key Details :

Key Value

Difficulty Level Difficult

Item Year CPCT 2021

Topic Data Interpretation
Sub Topic Word triad




Objective Knowledge
Form SET 68
BankStatus Mock

Three words are given, which are related in some way. Select the option in which the three words are related in the same way.

Hunt : Pleasure : Panic
Options :

1. # Death : Disease : Germs
2. % Game : Match : Win

3. % Theft : Gain : Loss

4. % Rain : Cloud : Flood

Question Number : 68 Question Id : 25498919650 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No

Correct Marks : 1 Wrong Marks : 0
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In each of the following, four words have been given, out of which three are alike in some manner, while the fourth one is different. Choose out
the odd one.

Options :

1. # Madagascar

2. % Thailand

3. % Cuba

4. # QGreenland
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2. ¥ YBdg
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Branch of biology in which we study about relationship between living and their environment is called:
Options :
1. # Physiology

2. % (enetics



3. ¥ Ecology
4. # Geology
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Options :

1. # W(Physiology)
2. % 3IATRID A7 (Genetics)
3.¥ 1il'i)\"@llﬁlﬁ(Ecology)
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In which year were the first Winter Olympic Games held?

Options :




1. * 1896
2. % 1904
3. % 1912
4.+ 1924
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1. % 1896

2. % 1904

3. % 1912

4.+ 1924
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The Geysers, a large steam reservoir north of San Francisco, USA, is the world’s largest source of:
Options :

1. # coal

2. % geothermal power

3. % hydropower

4. # natural gas
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Sundarbans of Eastern India is an example of:
Options :

1. # Forest Ecosystem

2. ¥ Mangrove Ecosystem

3. % Grassland Ecosystem

4. ¥ Marine Ecosystem
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Wasim Akram of Pakistan is associated with:

Options :

1. # politics

2. # martial law
3. # nuclear tests
4. ¥ cricket
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Which of the following groups of gases contributes to the ‘Green House Effect’?

Options :

1. ¥ Carbon dioxide and Methane

2. % Ammonia and Ozone

3. % Carbon monoxide and Sulphur dioxide

4. % Carbon tetrafluoride and Nitrous oxide
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Summer camps are supervised camps conducted to entertain as well as equip students with various life skills such as teamwork,
socializing, decision making, independent and responsible living and more. It aids the overall development of a child and children have



fun during this process as they get to explore new arenas.
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Nowadays, keeping yourself motivated has become very important. In this society of letting people down in every way has encouraged
everyone to put a step towards motivating themselves. Here are six ways that will help you to keep yourself motivated and keep you
moving forward in every situation. Build a business around your passion. When you do something you truly love it is not hard to find the
motivation needed to succeed. If you are involved in an industry that bores you it will be hard to find that motivation. Always have long-
term and short-term goals. Both short term and long term goals give you something to work for, and including short-term goals make
sure that you are able to taste success on a regular basis providing further motivation to push you towards achieving the long-term goals.
Be extremely positive. When you are constantly cheerful you focus on just the positives, which helps you stay motivated and focused on
reaching your goals. The minute you start to bring negative thoughts into your mind is the moment your positiveness mixes up in the
sand. Commit to the end goal. Success often comes to those who take big risks, and big risks can result in failures. There are very few
who hit wonders as most successful entrepreneurs have experienced failure at one point. Even if you have failed in the past, commit to
your end goal and don not think about those past failures or the possibility of failing again. It could happen but you could also be the
next success story. This whole story comes to the above one that if you lose your confidence of doing better you will never get success.
Surround yourself with likeminded people. The company you surround yourself with has a direct influence on how you behave, both in
your personal life and in the workplace. People around you decides the energy that keeps on rotating around your head. You should be
very serious in the choice of environment where you want to live in. Establish a personal reward system. It is always nice to be rewarded
for your hard work and you can all benefit yourself greatly by giving a personal rewards. It does not have to be expensive, sometimes
simple rewards can motivate you to push forward harder. Friday afternoon pizza for the office if all goals are hit for the week is a great
way to keep a team motivated and pushing hard, while you might reward yourself with an early Friday departure from the office if
personal performance goals are successfully completed. Trips, cars and material items can be used for larger goals and they can
encourage that little bit of extra motivation needed to taste victory. Experiment with different rewards to see what works best for you
and your team. At last motivating yourself has nothing to do with the stress and tensions, if you feel motivated then there is nothing that
you cannot do. You can try different tactics to feel confident about what you do and this will lead to motivational journey.
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